AOO/NNDI

PROGRAMMING SOFTWARE

KPG-7D

INSTRUCTION MANUAL

KENWOOD CORPORATION

CPRINTED IN JAPAN Bg2-0277-08{M}
93/l654321 9212110987654 321



Precautions for handling floppy disks

Take the following precautions when handling the KPG-7D programming
software floppy disk.

e Do not touch the magnetic surface of the floppy
disk.

e Do not bring any magnet or magnetic object near
the floppy disk.

o Do not bend the floppy disk.

e Do not use a ballpoint pen to write on the index
label of the 5.25" floppy disk.

e Do not place the floppy disk in places which are
either very hot and humid or very cold and dry.

e Always put the 5.25" floppy disk back into its
; envelope after use.

e Always put the 3.5" floppy disk back into its case
after use.
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1 Preface

Contents of this chapter
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1-4 A list of the items included in this package ..................... P6
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1-1 QOverview

The KPG-7D programming software for the TK-830, TK-730, and TK-830 transceivers is supplied on both
5.25" and 3.5" floppy disks.

P @Qutline of functions

The KPG-7D programming software inputs transceiver data 1o a computer.

The input data can be directly written to the TK-630, TK-730 and TK-830 transceivers when
they are connected to a computer, or printed out to paper. In addition, data can be read
from the transceivers for display and editing.

@ Hardware and software

OComputer
The KPG-7D software has been developed to be run on the 1BM PC/XT, PC/AT, PC/P32

computers with a RAM capacity of at least 350 KB.

OO0perating system
The operating system of your computer must be IBM-DOS version 3.1 or later.

(O Communication port
Your computer must have a serial communication port in order to write data o and read
data from the transceiver. This serial communication port must be compatible with the IBM
asynchronous communications adapter. The port used may be either COM 1 or COM 2.

OCommunication interface cable
The KPG-4 communication interface cable is required to send data to and read data from
the transceiver.



1-2  Connecting the equipment

This section describes how to connect the TK-630, TK-730 and TK-830 transceivers to a personal

computer using the KPG-4 programming interface cable.

1

4

Turn off the power to the computer,
Refer to the operating manual of your computer for details on set-up.

Turn off the power to the transceiver.

Connect the 25-pin connector of the KPG-4 cable to the COM 1 or COM 2 port of
your computer.

¥ the COM 1 or COM 2 ports on your computer are §-pin connectors, usa a cable
adapter 1o convert the 9-pin connector into a 25-pin connector, and then connect the
KPG-4 to the computer via the adapter.

Connect the other end of the KPG-4 cable to the microphone connector of the
transceiver.

Turn on the power to the computer.

Turn on the power to the transceiver while haolding down KEY 1 and wait about two
seconds.

The transceiver wil enter the program mode at this point, If the transceiver header is
a KGH-3, "PG" will be indicated on the LCD display panel. If the transceiver header
is a KCH-4, "PROGRAM" will be indicated on the LCD display panel.

Start the KPG-7D program. Refer to the appropriate section of this manual for details
on starting the program. When all read or write operations from or to the transceiver
are terminaled, a KCH-3-configured transceiver indicates this by displaying "EN" on
the LCD display panel, A KCH-4-configured transceiver indicates this by displaying
"END" on the LCD display panel.

Press KEY-2 to return the transceiver to the program modse. Both read and write
operations can now be performed to and from the transceiver,

Figure 1-2 shows the set-up for running the program on an IBM PC,

Figure 1-2

8-pin to 25-pin conversion cable KPG-4 o
{Programming interface)

KCH-3 or KCH-4



1-3 Installing the program

This section describes how to install the KPG-7D program from the original floppy disk to another floppy disk or
to a hard disk.

@|nstalling onto a floppy disk
For this example we will assume that the current drive is drive C, and that the (original} KPG-7D floppy
disk ic inserted into drive A. The floppy disk onto which the KPG-7D program is to be installed is in drive

Change the current drive from drive C to drive A. When "C:¥ >" is displayed on the DOS screen,
enter "A:" and press the Enter key. The current drive will change to drive A, and the DOS screen
then displays "A¥ >".

Insert the floppy disk onto which you wish to install the KPG-7D program inta drive B.

Enter "INSTALL B:" and press the Enter key. The KPG-7D program will now be instalied onto the

floppy disk in drive B.
If the KPG-7D program disk is already in the current drive, Step 1 can be omitted. In that case,

begin from Step 2.

@nstalling onto a hard disk

For this example we will assume that the current drive is drive C and that the KPG-7D program disk is

inserted in drive A.

Change the current drive from drive C to drive A. When "C:¥ >" is displayed on the DOS screen,
enter "A:" and press the Enter key. The current drive will change to drive A, and the DOS screen
then displays "A¥ >".

Enter "INSTALL C:" and press the Enter key. The KPG-7D program will now be installed onto the
hard disk.

iz ]



1-4 List of items inciuded in this package

Instruction Manual (B62-0277-08) .. ...ttt s 1

Program Disk 3.5" (720 K byte Format) ............ B R
[

Program Disk 5.25% (360 Kbyle Format) ....... . it it ey 1

1-5 READ . ME FILE

If revisions have been made to the program or if the descriptions in this manua! are insufficient, a "READ
ME FILE" is added to the program disk. The Read Me File contains descriptions of revisions which have
heen made or additional explanations. If there have been no changes, there may be no READ ME FILE
on the floppy disk.

1-6 Applicable radio Models

(ORADIO MODEL
TK-630 TK-730 TK- 830

(OCONTROL HEAD
Basic Control Head ( 32ch, 98ch )
Full Control Head ( 32ch, 160ch )

ORADIC CONFIGURATION
Single Control head + Single Band
Dual Control head + Single Band
Single Control head + Dual Band



1-7 System Flow - chart

Channe! Information Menu
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2 Initial settings

Contents of this chapter

2-1
2-2
2-3
2-4

Starting the program . ... ... . . . . e F8
Initial display . ... .. e Pa
Setting operationalflow . . ... ... ... . L oo, P10~P11
Quitting the program .. .. ... . P11

2-1 Starting the program

This section explains what to do after you have connectaed the equipment and turned your computer on.

1 When you see the IBM-DOS screen displayed on your computer after power-up, insert the KPG-
70D program floppy disk into the disk drive you wish 1o use.

2 Far this example we will assume the current drive is drive G and that the KPG-7D floppy disk is
inserted into drive A. You must change the current drive from drive G to drive A. When "C:¥ >
is displayed on the DOS screen, enter "A:", and press the Enter key.

The current drive will change to drive A, and the DOS screen then displays "Ar¥ =",
If the KPG-7D floppy disk is already in the current drive, Step 2 can be omitted. In that case, go
directly from Step 1 to Step 3.

3 Enter "KPGE7D", and press the Enter key.

4 The KPG-7D program starts up and the "LOADING PROGRAM, Please walt" message appears on
the screen. Figure 2-1 show the screen.

Figure 2-1

KPG-7D RADIO PROGRAMMING SOFTWARE
FOR TK-630 / 730 / 830 SERIES RADIO

VERSION 1.00
RELEASE 1/1/82

COPYRIGHT KENWOQD CORPORATION
1892 ALL RIGHT RESERVED

Hit any key to start.




2-2. Initial screen
This section describes the primary, display, referred to as the initial screen. It is the first to appear after you have
started the KPG-7D program as explained in Section 2-1.

1 While the screen shown in Figure 2-1 is displayed, press any key on the keyboard to display the
screen shown in Figure 2-2.

Figure 2-2
| File Modei Edit  Program  Selup Fi=Help |
Basic 32ch Radic UHF  :450 -470 Model : 8305532B
Single Head Single Band File ¢ KPG7D. B38
CH Frequency QT/oar SCN OPT
No Receive Transmit Decode Encode DiA SIG
1
2
3
4
5
6
7
B
g
10
11
12
13
14
15
16
{ Arrows: Move Enler : Input Fa: Fregq Cpy All: Golo Menu )

* CHANNEL INFORMATION screen
Figures 2-2 and 2-3 show the screen which is used to specify settings and modes for the
channels. In this manual, it is referred to as the CHANNEL INFORMATION screen. For details,
see Chapter 4 CHANNEL INFORMATION screen.

* Menu
At the top of the screen there is a menu bar with the tities of the various menus available. The
term “menu” as used in this manual refers to a title under which a number of the items required to
perform the editing and processing of data and screens are grouped.

* Keys frequently used with the screens displayed by the KPG-7D program and their functions are
described below.

@ Arrow keys
Moves the cursor to an item for making an entry.

@Enter key
Executes the program and finalizes input data.
@ Alt key
" Opens a menu window or returns to the previous screen.
@tlelp key (=F1 key)
Digplays help messages. Pressing the F1 key will display the help message corresponding to the
menu window that is open at the time.

@F2 o F10 keys

Selects the functions assigned to those buttons as displayed in the various windows and screens.
@ PageUP/PageDN keys

Moves the Help Message display page forward or back one page at a time.

@ESC key
Returns the program to the CHANNEL INFORMATION screen.



2-3 Setting operational flow

This section describes the operational flow of three typical setting operations using the KPG-7D program,

I. Creating and writing new data to the transceiver:

Specify the transceiver model type (Model).

\/

Set the data (EditYCHANNEL INFORMATION).

N\

Write the data to the transceiver (Program/Write).

\

Save the data onto a disk (File/Save As).

2 Modifying data previously written to the transceiver

Read the data from the transceiver {Program/Read).

Modify the data (EdiYCHANNEL INFORMATION).

\

Write the data ¢ the transceiver {Program/Wirite).

\

Save the data onto a disk (File/Save As).

10



3 Modifying data previously saved on a disk and writing them to the transceiver:

Read the data from a disk {File/Load).

\/

Modify the data (EdiVCHANNEL INFORMATION).

\

Write the data to the transceiver {Program/Write).

\

Save the data onto a disk (File/Save As).

2-4 Quitting the program

This section describes how to quit the program .
1 Open the File menu window. (section 5-2)

2 Move the cursor to "Exit" with the up- or down-arrow key, and press the Enter key. You ¢an also
use the Quick Key for the selection. The window shown below then opens.

Return t DOS !
[ OK ] [ CANCEL ]

3 Select either [OK] or [CANCEL] with the left- or right-arrow key or the Quick Key (section 3-1 or
3-2). If you select [OK], the program is shut down, and the operation returned to the DOS level
command prompt. !f you select [CANCEL], execulion is cancelled, and the program returns 1o the

previous screen.

11



3 Selecting and Inputting Data

This chapter describes how to select and input data using typical examples. There are
four methods by which you can select or input data. Make sure you have a clear
understanding of the procedures necessary to select and input data before attempting the
actual settings. The information in parentheses following the description of each procedure
refers to the section in which you can find an explanation of the selection or input method
used for that procedure. For example, for CHANNEL INFORMATION SCAN, (section 3-1,
or 3-2), directs you to see that section for the selection or input method required.

Contents of this chapter

3-1T Using the armmow KBYS .. it i it it ittt aas P13
3-2 Using the QUICK Key ... i it P13
3-3 Inputting directly from the keyboard ............ ... ... .l P14
3-4 Selecting and inputting from the Directory ..................... ... P15
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3-1 Using the arrow keys
Here we use a typical example fo explain this selection method. The method is similarly performed in

other cases as well. When you see the display shown below, use the left- or right-arrow key to select
either [OK] or [CANCEL].

Load Fils Name : KPD-7D0.B38

[ OK ] [ CANCEL ]

1 Press the left- or right-arrow key to move the cursor te the item you wish to select, either [OK] or
[CANCEL].

2 Press the Enter key.

3-2 Using the Quick Key
With a color monitor, Quick Key items are displayed in a different color from the other characters. {However,

the Quick Key items may be indistinguishable in black & white. In that case, you must specify your selection
using another method.)

Here we use a typical example to explain this selection methed. The method is similarly performed in other
cases as well. When you see the display shown below, press the Quick Key to select either [OK] or [CANCEL].

Load File Name : KPD-7D.B38

[ OK 1 [ CANCEL )

1 Press the Quick Key corresponding to the item you wish to select. Press the "O" key to select
[OK]. Press the "C" key to select [CANCEL].

i3



3-3  Inputting directly from the Keyboard

Here we use a typical example to explain this selection method. The method is similarly performed in
other cases as well.

(DWhen you see the display shown below, enter the drive and the path name directly from the keyboard.
The drive and path name displayed are the default names.

Step Drive & Path

[ ANKPGYDADATA ]

1 Press the left-arrow key to move the cursor to the leftmost {heading) position where it blinks.
2 Press the Del key to delete the drive name and the path name that are already there.
3 Enter the new drive and path name in the correct sequence starting from the left using the

alphanumeric keys on the keyboard.

4 Press the Enter key.

@When you see the display { CHANNEL INFORMATION screen ) shown below, enter the Frequency
Data directly from the keyboard.

CH CH Frequency
No Name Receive Transmit
1 GR1CH1  450.0000 451.0000
2 GR1 CH2
i
1 Pressing the Insert key causes the cursor to change from a — toa [, and the background color

of the entry area changes. {In black & white, the area is reverse-highlighted.)

2 Move the cursor to the position you wish ta change using the arrow keys, and enter the desired
character(s). '

3 Press the Enter key.

14



3-4 Selecting and inputting from the Directory

When the Directory window, shown below, is displayed, press the up- or down-arrow key to select the desired

fiie name from among those displayed. The file name is one example.

Directory

KPG-7D . B36
KPG-7D . B37
KPG-70D . B33

Press the up- or down-arrow key o move the cursor to the file name you wish to select. If there
are more file names than can appear in the window, you can scroll undisplayed file names into the

display window by holding down the down-arrow key.

2 Pross the Enter key.



4 CHANNEL INFORMATION

Contenis of this chapter

L B O =T 11T P16~P17
4-2 Setting the various items in the CHANNEL INFORMATION screen P18~ P20

4-1 Overview

This section describes the CHANNEL INFORMATION. Figures 4-1, 4-2, and 4-3 show the CHANNEL
INFORMATION screen. The CHANNEL INFORMATION screen is the one which is normally displayed when
you are running the KPG-7D program and it is in this screen that settings such as CHANNEL are made. The
methods for setting the various items are desciibed in the following pages.

Figure 4-1

I File Model Edit Program  Selup Fi=Help

Basic 32ch Radie UHF :450-470 Model : 830S332B
Single Head Single Band File : KPGTD.B38

CH Frequency QuoQT SCN OPT
No Receive Transmit Decode Encode DA S1G

{ Arrows: Move Enter: Input F4:Freq Cpy Alt: Gote Menu }
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Figure 4-2

File Model Edit Program  Setup Fl:HeIpJ
Basic 32¢ch AN Radicl UHF :450-470 Model 830DS32B/A
Single Head Dual Band Radie?2 VHF Hi:150-174 File SAMPLE.A3B
CH CH Frequency QTDQT SCN  OPT Scrambler
No Name Receive Transmit Decode Encode D/A  SIG V/SC  Code
1 1 450.00000 455,00000  67.0 67.0 Add No No i
2 2 451.00000 456.00000 100.0 100.0 Add No Mo H
3 3 150.00000 150.00000D134N D134N Add Ne No 1
g g 160.00000 160.00000 D411l D4111 Add No No 1
6 6
ki 7
3 8
9 9
it 10
11 11
12 12
13 i3
14 i4
15 15
16 16
{ F3:Ch Cpy FL0:Pri Ch Set  Alt:Goto Menu )
Figure 4-3
[ File Model Edit Program Setup F1 =HelpJ
Full 32ch Radio UHF :450-470 Model 830DS832F
Dual Head Single Band File KPGT7L}.Bag
GRP: 1 Group Del/Add:[Delj
CH CH Frequency QT/DAT SCN  OPT Scrambler
No Name Receive Transmit Decode Encode /A SIG Vi3C  Code
1 GR1 CHI1
2 GR1 CH2Z
3 GR1 CH3
4 GR1 CHA4
5 GR1 CH&S
6 GR1 CHE
7 GR1 CH7T
8 GR1 CHB8
9 GR1 CHEY%
10 GR1 CH 10
11 GR 1 CIi 11
12 GR1 CH 12
13 GR 1 CH i3
14 GR 1 CH i4
15 GR1 CH 15
16 GR1 CH 16
{ [3:Ch Cpy F7: Next F8§:Prev Alt: Goto Menu }

17



4-2 Setting the various items on the CHANNEL INFORMATION screen

Move the cursor to the channel and item you wish to set. |f you have configured channels into groups, use the
F7 and F8 keys to select the group you wish to set before moving the cursor. Whaen the setling is completed,
the cursor moves to the next item. (i a settings window is open, close it first.)

@ Priority Channel indication
If you set Priority 1 or 2 as either "Fixed” or "Operator Selectable" in the Scan Information window in the

edit menu, pressing the “ F10 key: Priority Set ” displays “1” or "2" at the left of the channel number
of the relevant channel(s) depending on whether the channels are set as Priority 1 or Priority 2.

@ Channel Name
By adding the KCH-5 option to a basic centrol head package, you can have two alphanumeric characters
for the channel name. By adding it fo a full control head package, you can have twelve alphanumeric
characters. You can enter an easy-to-understand name for each channel and display the names for the
channels instead of their numbers.
1 Enter the desired channel name directly from the keyboard.

2 Press the Enter key.

@ Frequency (Receive /Transmit )
1 Enter values for the Receive Frequency and the Transmit Frequency within the band setting range
directly from the keyboard.

2 Press the Enter key.

® Signaling QT 7/ DQT ( Decode /Encode )
You can enter the values for QT/DQT Decode/Encode directly from the keyboard or you can press the F2
key and select a setting from the chart which is thereby displayed. If you are selecting DAT, enter a "D"
before the DQT DATA entered, and an "N" or an "I" after. For example, if you wish to specify DGT
DATA 777 NORMAL, enter "D777N". If you wish to use DQT DATA 555 INVERSE, enter "D5551". ("N”
need not be typed in the case the setting is "NORMAL". The KPG-7D program will automatically put
"N* in the proper location.)
1 Enter QT/DQT DATA directly from the keyboard
(or  Press F2 Key to display the QT/DQT chart. Make your selection by moving the cursor to the

QT/DQT valug you wish to use.)

2 Press the Enter key.

@ SCAN ( DELETE / ADD )
When you enter the Receive Frequency, “Add" is set as the default. The option you specify here simply
becomes the preset value for D/A under the Key Selection menu item. The user-specified value for the
D/A key lakes precedence over the default value. If you do not set the D/A key, this value remains fixed.
1 Press the Enter key to open the settings window.

2 Select [Delate] or [ADD] with the arrow key(s) or the Quick Key (section 3-1 or 3-2).

{or  You can alternate between the [Delete] and [ADD] selections by pressing either the F2 key or the
space bar. Select either [Delete] or [ADD], and press the Enter key.)

18



® Optlion Signaling
You can enable and disable the signaling unit option on a per-channel basis. By specifying [yes] for this
itern, squefch is controlled by the option signaling unit.

1

2
{or

@ Scrambler

Press the Enter key to open the settings window.

Select either [Yes] or {No] using the arrow keys or the Quick Key (section 3-1, or 3-2).
You can alternate between the [Yes] and [No] selections by pressing either the F2 key or the
space bar. Select either [Yes] or [No] , and press the Enter key. }

This is displayed only when you have selected "Installed....Yes" when specifying the model type. You
can enable and disable lhe scrambler option for each channel. The default setling is "No".

1

2
{or

Press the Enter key 1o open the setlings window.

Select either [Yes] or [No] with the arrow keys or the Quick Key (section 3-1, or 3-2).
You can allernate between the {Yes] and [No] selections by pressing either the F2 key or the
space bar. Select either [Yes] or {No], and press the enter key.}

@ Scrambler Code
This is displayed only when you have selected "Installed....Yes™ when specifying the transceiver model

type.
1

(or

2

There are sixteen codes (1 to 16} from which a selection can be made for each channel.
Enter the desired scrambler code direclly from the keyboard.
Select a code number from 1 1o 16 using the F2 key.)

Press the Enter key.

@IF Frequency <Shift + F6 : IF / STEP >
The IF irequency should be set only in the case ol special specifications. Normally, it should be left at
the default setting.

1

2

3

4

5

Fress theShift + F6 key to open the settings window. Move the cursor to “iF frequency”.
Enter the desired IF frequency directly from the keyboard.
Press the Enter key.

Press the Alt key to open the confirmation window. Select [OK] to confirm the selling or select
[Cancel] to cancel the setting.

Press the Enler key.

@ Frequency Step <Shift + FB 1 IF/ STEP >
The frequency step should be set only in the case of special specifications. The frequency step is
determined for each band by the FCC, so do not change it. However, it can be switched in some bands.
For example, the 10 kHz ~ 12.56 kHz band or the 5 kHz ~ 6.25 kHz band.

1

2

3

Press theShifl + F6 key to apen the settings window. Move the cursor to "Frequency Step”.
Press the Enler key. A second settings window now opens.
Select the desired Frequency Slep with the arrow keys or the Quick Key (section 3-1, or 3-2).

Press the Alt key to open the confirmalion window. Select [OK] to confirm the setting or select
[Cancel] 1o cancel the selling.

Press the Enter key.
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@ Pricrity Set < F 10 : Priority Set >

If you set Pricrity 1 CH or Pricrity 2 CH to either "Fixed" or "Operator Selectable™ in the Scan

Information display, <F10:Priority Set> will appear in the Key menu at the bottom of the display to

enable channel setting.

1 Press the 10 key to open the seltings window. If you have set both Priority 1 Channel and
Priority 2 Channel to either "Fixed" or “Operator Selectable”, both Priority 1 and Priority 2 will
appear in the seltings window. If you have set enly one of them to "Fixed” or “Operator
Selectable”, then only that one will appear in the settings window.

2 Select the desired priority channel with the arrow keys (section 3-1}.

X The operation of other keys

® Control [ Cul ] Key
The statuses of Priority 1 and 2, and the assignments of the OPT and Aux keys are displayed for your
information.

®Shit + F3
Group Copy (full-featured model only): Copies channel data from one group to ancther group.
1 The settings window opens.,

Group Copy

GR 1 - GR [ ]

2 The group given in the window is the source group. From the keyboard, direclly enter the number
of the group you wish to copy to.

3 Press the Enter key {0 execute. Press the Alt key if you wish to abort the process.

@ Shift + F4
QT/DQAT Copy: Copies the decode tone (QT/DQT) of the channe! the cursor is positioned at to the
encode tone, '

1 The sellings window opens.
2 Press the Enter key 1o execute. Press the Alt key if you wish to abort the process.
®3hift + F9

Channel Insert: Inserts a new channel to the channel location where the cursor is currenlly positioned.
The channels after the new position all shilt back one position. However, you cannot insert new
channel(s} if there are data set to the last channe! (either channel 32 or channat 89 on the basic model,
and channel 18 of the group currently being displayed on the full featured model).

®Shit + F10
Channel delete: Deletes the channel where the cursor is positioned. The channels after the deleted
channel all move up one position in orde:.

@HOME
The cursor jumps to the channel 1 position (group 1 channel 1 in the full featured model).

®END

The cursor jumps to the last channel {either channel 32 or channel 99 on the basic model, and channel
16 of either group 2 or group 10 on the full lealured model).
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5 Menu

Contents of this chapter

o T 0 )17 -Y VU= 3 U L EEER TR P21

5-2 Opening the menU WiNOWS ... ..o iiiiiiiineiiiiiiianienns P22

5-1 Qverview

The term "menu” as used in this manual refers to the title under which the items required to edit and set the
processing of data and screens are grouped. The menus include File, Model, Edit, Program, Setup, and
F1=Help. The menu bar shown below is displayed at the top of the screen.

| File Model Wit Program  Setup F1=Help |

Below are brief descriptions of the functions of the various menus.

®Fie
The File menu allows you to create, save, open, delete, and print data files residing on a disk, as well as
exit the program or the operations of the current screen.

® Model
The Model menu allows you to set the model type of the transceiver you will be writing data to.

@ Edit
The Edit menu allows you to edit all data other than channel information.

@ Program
The Program menu allows you to write data to and read data from the EEPROM (memory) in the

transceiver.

@ Setup
The Setup menu allows you to set the port to which you wish to connect the KPG-7D programming
interface cable, the color of the display, and the drive and path name of the Help file.

®Fi=Help
The F1=Help menu displays help messages.
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5-2 Opening the menu windows

This section describes the keyboard operations by which you can display the "frames” of the varicus menus
which contain the lists of commands for setting and selecting data. In this manuat these frames are referred to
as "windows", and displaying one of these frames is "opening a menu window". Making a frame disappear is
"closing a menu window".The information in parenthesis {section’ 5 - 2} of each procedure refers to this
sectionin which you can open the menu window.

1 Press the Alt key with the CHANNEL INFORMATION screen displayed on your menitor. However,
if any window other than one of the menu windows is open, press the ESC key first to exit that
window before pressing the Aft key.

2 The "File menu window" shown in Figure 5-2 opens under the File menu. If you press the Alt key
again while the File menu window is open, it closes. Each time you press the Alt key, the window
alternately opens and closes.

| File Model  Edit Program Selup F1=Help
MNew 9ch Radic UHF : 450 -470 Model @ 83085098
Load- hoaq Single Band File : KPG7D . B38
Save
Save As
Delete
Print Frequency QT/DaT SCN OPT  Scrambler
Receive Transmit Decode Encode D/A SIG ViISC  Code
Exit
3
4
a
3
b
8
9
10
11
12
13
14
15
16
{ Amows: Move Enter 1 Select Alt: Golo Menu )
Figure 5-2
New
Load
Save
Save As
Delete
Prinl
Exit
3 If you press the right- or left-arrow key while the File menu window is open as shown in Figure 5-2,

ithe menu windows under the various menu titles will cpen as you move the cursor aleng the menu
bar. However, only the menu window directly below the cursor is open at any oneg time; all other
windows are closed. The windows for all the menus are shown below.

Fiie Model Edil Program Selup F1=Heip ;
New Basic 32ch Key Selection Read from Radio. || Communication Pori General help
Load basic 99ch Scan information Wrile to Radio . Display color Keyhord help
Save basic 32ch AN | | Fealure Gplion Help Path
Save As Basic a99ch AN Embedded Message
Delele Full 32ch AN

- full 160ch AN
Print
Exit
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6 File
The File menu allows you to create, save, open, delete, and print data files residing on a
disk, as well as exit the program.

Contents of this chapter

2 I ¥ eeaeaeneas P23
T o T Y o 1 O P24
B3 SV ...ttt e e e e P25
B4 SAVE AS i e i e e et P26
B-0 D ole i e e e it P27
B-8  PUINt e i e P28
A | e P28
6-1 New

The New function clears the data file already created and allows you to create a new file. This operation sets all
data to their initial values.

1 Open the File menu window. (section 5-2)

2 iMove the cursor to “New" with the up- or down-arrow key, and press the Enter key. You can also
use the Quick Key for the selection. The window shown below then opens.

WARNING |
ALL DATA will ba cleared.

[ OK ] [ CANCEL ]

3 Select either [OK} or [CANCEL] with the left- or right-arrow key or the Quick Key (section 3-1., or
3-2). If you select [OK], all data settings are reset to their initial values and the program returns to
the CHANNEL INFORMATION screen. If you select [CANCEL], execution is cancelled, and the
program returns to the previous screen.
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6-2 Load

The Load function reads transceiver data files previously saved on a hard disk or a floppy disk and writes them
into the buffer memory of your computer.

1
2

Open the File menu window. (section 5-2)

Move the cursor to "Load™ with the up- or down-arrow key, and press the Enter key. You can also
use the Quick Key for the selection. A window opens dlspiaymg the drive and path name of the
file currently loaded, as shown below,

Drive & Path: ANMKPGTDADATA

Enter the drive and path name of the desired file directly from the keyboard g_section 3-3). The
window shown below then opens. This window displays the name(s) of the file{s) on that path.The
file name is one example. (Note * Expansion element)

. D_ireclory

KPG-7D.B38
KPG-7D.B37
KPG-7D.B38

Select the desired file name with the up- or down-arrow key. (section 3-4) The window shown
below then opens.

Lead File Name . KPD-7D.B38

[ OK ] [ CANCEL ]

Select either [OK] or [CANCEL] with the right/left arrow keys or the Quick Ke Eection 3-1 or 3-
2). It you select [OK], the file is loaded and the program réturns to the CHANNEL INFORMATION
screen. If you select [CANCEL], execution is cancelled, and the program returns to the previous

screen.

Note ™ Expansion elemant

Expansion element

1
LEEEEEE ST I B [ Radio 1 Band
(I | .| 6:VHF LOW
File Name o 7 1 VHF HIGH

8 : UHF

[~ Channel number

- 3 : 32ch
9 : 839 c¢ch
| 1 : 160 ¢ch

" Control Head Type

B : Basic Control Head
A ! Basic + Alphanumeric
F : Full Contral Head

Y

24




Modet Edit Program Setup ' F1=Help J

6-3_SAVE

The Save, function saves the data file you have created to the data file name at the current drive and path
name. Thls method permits you to omit selecting the file name input type and the drive and path name of the

data file.
1 Open the File menu window. (section 5-2)

2 Move the cursor to “Save® with the up- or down-arrow key, and press the Enter key. You can
also use the Quick Key for the selection. The window shown below then opens. This window
displays the drive and path name of the file currently loaded.

Save File Name : SAMPLE . B38
[ OK ] [ CANCEL ]

3 Select either [OK] or [CANCEL] with the left- or right-arrow key or the Quick Key {section 3-1 or
3-2). If you select [OK], the data is saved and the program returns to the CHANNEL
INFORMATION screen. If you select JCANCEL], execution is cancelled, and the program returns

to the previous screen.
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6-4 SAVE AS

The Save As function saves the data file you have created onto a specified disk. You must specify the drive
and path in this case. If the drive and path are not specified, an error occurs. To prevent this, creale a drive

and path name to a data file disk in advance.

1

2

3

4

Open the File menu window. (section 5-2)

Move the cursor to "Save As" with the up- or down-arrow key, and press the Enter key. You can
also use the Quick Key for the selection. The window shown below then opens. The drive and
path name displayed in this window is the default path.

Setup Drive & Path

[ A:\KPG7D\DATA]

Enter the desired drive and path name directly from the keyboard (section 3-3). The window
shown below then opens. The file name appearing in this window is the default file name.

Save File Name

[ SAMPLE |

Enter the desired file name directly from the keyboard (sectioh 3-3). Or press the F9 key fo open
the Directory window. You can then select the file name from the Directory window. (section 3-

4)

Save File Name : SAMFLE.B38
[ OK ] [ CANGEL ]

Select either [OK] or [CANGEL] with the left- or right-arrow key or the Quick Key {section 3-1 or
3-2). If you select [OK], the data is saved and the program returns to the CHANNEL
INFORMATION screen. If you select [CANCEL], execution is cancelled, and the pregram returns
o the previous screen.
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6-5 Delete
The Delete function deletes a data file which has been already created. This allows you to delete unneeded
data files from a specified disk so that you can ensure sufficient disk space and eliminate waste,

1 Open the File menu window. (section 5-2)

2 ' Move the cursor to "Delete” with the up- or down-arrow key, and press the Enter key. You can
also use the Quick Key for the selection. The window shown below then opens. The drive and
path name displayed in this window is the default path.

Setup Drive & Path

[A:\VKPG7DADATA ]

3 Enter the desired drive and path name directly from the keyboard (section 3-3). The Directory
window shown below opens. The file names shown here are only examples.

Directory

KPG-7D.836
KPG-70.B37
KPG-7D.838

4 Select a file name (section 3-4). The window shown below then opens.

Delele File Mame : KPG7D.B38
[ OK ] [ CANCEL ]

5 Select either [OK] or [CANGEL] with the feft- or right-arrow key or the Quick Key (section 3-1 or
3-2). if you select [OK], the file is deleted and the program returns io the CHANNEL
INFORMATION screen. if you select (CANCEL], execution is cancelled, and the program returns

to the previous screen.
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6-6__ Print

The Print funclion outputs data you have created, data from a data file disk you have loaded or data read from
the transceiver fo the printer and prints them out. You can print out as follows.,

—

e

Model Type

File Name

Embedded Message
Model Type Configuration
Key Selection

Scan Information

Feature Cption

Frequency Step

Other Information
Channel information

Open the File menu window. {section 5-2)

Move the cursor to "Print” with the up- or down-arrow key, and press the Enter key. You can also
use the Quick Key for the selection. The window shown below then opens.

Edit Data Print Qut .
[ OK ] [ CANCEL ]

Select either [OK] or [CANCEL] with the left- or right-arrow key or the Quick Key (section 3-1 or
3-2). If you select [OK], the data are printed and the program returns to the CHANNEL
INFORMATION screen. If you select [CANCEL], execution is cancelled, and the program returns
to the previous screen.

6-7 Exit

The Exit function shuts down the KPG-7D program and returns you to the DOS level.

1

2

Open the File menu window. {section 5-2)

Maove the cursor to "Exit" with the up- or down-arrow key, and press the Enter key. You can also
use the Quick Key for the selection. The window shown below then opens.

Return 1o DOS |
[ OK 1] [ CANCEL }

Select either [OK] or [CANCEL] with the left- or right-arrow key or the Quick Key (section 3-1 or
3-2). If you select [OK], the program is shut down, and the operation returned to the DOS level
command prompt. If you select [CANCEL], execution is cancelled, and the program returns to the
previous screen.
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7 Model
Contents of this chapter
-1 OVOIVIOW oottt ittt e it st e e P29~ P30
7-2 Modeltype settings ...t P31~P36

7-1 Overview

The Model menu is the menu used to set the transceiver model type. Because the items to be set under the
Edit menu depend on the transceiver model type, you must first set the model type when creating a new data
file. Mode! type settings consist of "Control Head Type", “Radio Configuration”, and "Radio Band: Single or
Dual". Each setting is described below.

|
@ Control Head Type
There are five types of Control Heads, as listed below. The manner in which they are displayed in the Model
menu window are as shown at the right of the arrows below.

(OBasic Control Head (32¢ch) — Basic 32ch

QO Rasic Control Head + KCH-5/2 { 99¢h ) — basic 99ch
(OBasic Control Head + KCH-5/2 { 32¢ch Alphanumeric ) — basic 32ch AN
(OBasic Control Head + KCH-5 ( 99ch Alphanumeric ) - basic 99ch AN
OFull Featured Control Head { 32ch Alphanumeric ) — Full 32ch AN
OFull Featured Control Head + KCH-5 (180ch Alphanumeric } — full 160ch AN

In addition, there are options for the control heads as outlined below.

(OKCH-3 Basic Front Panel Kit
The basic model is equipped with this type of control head. It is required when you configure your model
as a dual control head, but you do not select KCH-4 from within the program.

QOKCH-4 Full Featured Front Pannel Kit
The full-featured model is equipped with this type of control head. It is required when you configure your
model as a dual control head, but you do not select KCH-5 from within the program.

OKCH-5 Channel Expansion Kit
This is a channel expansion kit for both the basic model and the full-featured model. You use this kit to
expand the basic model from 32 channels to 99 channels, and the full featured mede! from 32 channels

to 160 channels. The KCH-5 EEPROM, added to the head of the basic model, allows you to display
channel names using alphanumeric characters.

® Radio Configuration

There are three types of Radio Configuration as follows.
OSingle Contro! Head , Single Band

ODual Control Head ,Single Band

OSingle Control Head , Dual Band
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® Radic Band
The range of frequencies differs according to the model type. The available bands are listed in the

following table,

£dit

Program Setup

F1=Heip

Model Type

Frequency
Band

Frequency Range (MHz )

TK-630

VHF LOW

F1:29.7~37

F2:35~43

F3:41~50
Special Tune: 29.7~50

TK-730

VHF HIGH

F1:150~174
F2:136~156
Special Tune : 136~174

TK-830

UHF

F1i:450~470
F2: 470~480
F3:490~512
F4 1 403~430
Special Tune : 400~520
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7-2 Mode! type settings

Descriptions are given for the following three radio configurations.
(Osingle Control Head + Single Band

(O8Single Control Head + Dual Band
(ODual Control Head + Single Band

Osingle Contol Head + Single Band
1 Open the Model menu window (section 5-2)

2 Select the controt head type with the up- or down-arrow key or the Quick Key (section 3-1 or 3-2).
The window shown below then opens.

Control Head

Single Control Head
Duai Conyrol Head

3 | Select "Single Control Head" with the up- or down-arrow key or the Quick Key {section 3-1 or 3-
2). The window shown below then opens.

Band

Single Band
Duai Band

4 Select "Single Band" with the up- or down-arrow key or the Quick Key {section 3-1 or 3-2). The
window shown below then opens. .

Radio Band

UHF
VHF Hi
VHF Low
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Select the radio band with the up- or down-arrow key or the Quick Key {section 3-1 or 3-2).

Depending on your selection, one of three windows corresponding to the cheice of radio band you
made then opens. These windows are shown below as @, ®, and ©.

@ ®

©

UHF VHF HIGH VHF LOW
1:450 -470 1:1580-174 1:28.7-37
2:470 - 430 2:136 - 156 2:35-43
3:490-512 3:8P Tune 3:41-50
4:400 -430 4: 5P Tune
5: 5P Tune

Select the desired frequency range with the up- or down-arrow key or the Quick Key (section 3-1

or 3-2). The window shown below then opens.

1s a VOICE SCRAMBLER UNIT
installed in this Radic { Deck ) ?
{ e.qg 5C-2460 )

[ Yes ] [ No ]

Select whether or not a voice scrambler unit is installed in Radio 1. Select [Yes] or [No} with the
lefi- or right-arrow key or the Quick Key (section 3-1 or 3-2). The window shown below then

opens. The window shown below assumes that you selected UMHF 470-430.

Model Type

Basic 32 ch
Single Head Single Band

Radio Band UHF 1470
[ OK 1] [ Cancel

- 490

]

Select JOK] or [CANCEL] with the left- or right-arrow key or the Quick Key (section 3-1 or 3-2). If

you select {OK], the model type is set as shown in the above window, and the program returns to
the CHANNEL INFORMATION screen. If you select {CANCEL], execution is cancelled anq the

program returns to the previous screen.
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(OSingle Contol Head + Dual Band

1 Open the Model menu window

2 Select the control head type with the up- or down-arrow key or the Quick Key {(section 3-1 or 3-

(section 5-2)

2). The window shown below then opens.

Control Head

Dual

Zingle Gontrol Head

Control Head

3 Select "Single Control Head" with the up- or down-arrow key or the Quick Key (section 3-1 or 3-

2}. The window shown below then opens.

Band

Single Band
Cual Band

4 Select "Dual Band" with the up- or down-arrow key or the Quick Key {section 3-1 or 3-2). The

window shown below then opens.

Radio 1 Band
UHF
VHF  Hi
VHF  Low
Radio 2 Band
URF
VHF M
VHF  Low
5, Select a radio band for the Radio 1 band with the up- or down-arrow key or the Quick Key {section
to3-ior 3-2(}. Depending on your selection, one of three windows corresponding to the chaice of
radio band you made for thé Radio 1 band then opens. These windows are shown below as &),
®, and ©.
UHF VHF  HIGH VHF  LOW
i:450 - 470 1:150 - 174 1:29.7- 37
2470 - 480 2:136 - 156 2:35-43
3:490 - 512 3:8P Tune 3:41- 50
41400 - 430 4:5P Tune
5; 8P Tune
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Select the desired frequency range with the up- or down-arrow key or the Quick Key (section 3-1
or 3-2). The window shown below then opens.

Radio1 Band

UHF
VHF Hi
VHF Low

Radio 2 Band

UHF
VHF  Hi
VHF Low

Select a radio band for the Radio 2 band with the up- or down-arrow key or the Quick Key
{section 3-1 or 3-2). Depending on your selection, one of three windows corresponding to the
choice of radio band you made for the Radio 2 band then opens. These windows are shown
below as &, ®, and ©.

UHF VHF  HIGH VHF  LOW
1:450 -47) 1:150- 174 1:29.7-37
2:470 - 490 21136 - 156 2:35-43
3:490 - 512 3:SP Tune 3:41-50
4 1400 - 430 4 : 5P Tune
5:5F Tune

Select a frequency range with the up- or down-arrow key or the Quick Key (section 3-1 or 3-
2). The window shown below then opens.

Is a VOICE SCRAMBLER UNIT
inslalled in this Radio ( Deck )} ?
{ e.g 9SC-2460 }

[ Yes ] [ No ]
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9 Select whether or not a voice scrambler unit is installed in Radio 1. Select [Yes] or [No] with
the left- or right-arrow key or the Quick Key (section 3-1 or 3-2). The window shown below
then opens. The window shown below assumes that you selected UHF: 490-512 for the Radio
1 band, and VHF HIGH: 150-174 for the Radio 2 band.

Model Type

Basic 32c¢h
Single Head Dual Band

Radio 1 Band UHF :490-512
Radio2 Band VHF HIGH :150-174
[ oK ] [ Cancel ]

10 Select [OK] or [CANCEL] with the left- or right-arrow key or the Quick Key (section 3-1 or 3-2).
If you select [OK], the system is set as shown in the above window, and the program returns to
the CHANNEL INFORMATION screen. If you select [CANCEL], execution is cancelled and the
program returns to the previous screen.

QO  Dual Control Head + Single Band
1 Open the Madel menu window (section 5-2)

2 Select the control head type with the up- or down-arrow key or the Quick Key (section 3-1 or 3-
2). The window shown below then opens.

Control Head

Single Control Head
Dual Control Head

3 Select "Dual Control Head" with the up- or down-arrow key or the Quick Key (section 3-1 or 3-
2). The window shown below then opens.

Radio Band

UHF
VHF Hi
VHF Low
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4 Select the radio band used with the up- or down-arrow key or the Quick Key {section 3-1 or 3-
2). Depending on your selection, one of three windows corresponding to the choice of radio
band you made then opens. These windows are shown below as @, ®, and ©.

| ® ® ©

UHF VHF  HIGH VHF LOW
1:450 - 470 1:150 - 174 1:29.7-37
2: 470 - 490 2:136 - 156 2:35-43
3:490-512 3:5P Tune 3:41-50
4 :400 - 430 4 : 8P Tune
5:5P Tune
5 Select the frequency range with the up- or down-arrow key or the Quick Key (section 3-1 or 3-

2). The window shown below then opens.

Is a VOICE SCRAMBLER UNIT
installed in this Radio ( Deck ) ?
( e.g SC-2460 )

[ Yes ] [ No )

6 Select whether or not a voice scrambler unit is installed in Radio 1. Select [Yes] or [No] with
the left- or right-arrow key or the Quick Key (section 3-1 or 3-2). The window shown below
then opens. The window shown below assumes that you selected UHF: 400-430.

Model Type

Dasic 32ch
Dual Head Single Band

Radic  Band UHF 1400 - 430
[ CK ] [ Cancel ]
7 Select [OK] or [CANCEL] with the left- or right-arrow key or the Quick Key (section 3-1 or 3-2).

If you select [OK], the system is set as shown in the above window, and the program returns to
the CHANNEL INFORMATION screen. If you select [CANCEL], execution is cancelled and the
program returns to the previous screen.
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8 Edit
!

Contents of this chapter
Bul  OVaIVIEW . i i i e e e P37~ P43
8-2 Key Selction ... .. i i e e P44~ P45
8-3 ScaniInformation .......... i i i P46~ P47
8-4 Feature Option ... ... e e e P48~ P50

8-1 Overview

The Edit menu aliows you to create various types of transceiver data. The Edit menu consists of "Key
Selection™, "Scan Information”, “Feature Option" and "Embedded Message”. Each is described separately in
this chapter. :

@ Key Selction

Assigns a function to each of the keys on the front panel of the basic control head or the fult control
head.

(OBasic Control Head

Shown below in the middle of the display is a representation of the basic control head front panel. The
functions which can be assigned to the MON, SCN, OPT, and D/A keys are listed in the Key Selection
window shown in Figure @®.

| Fie Model Edit Program Selup F1=Help I
Basic  99ch|Key Selection Radic UHF : 450 -470 Model : 830859¢B
Sinnlo Lol Sile . Mazh D90
| MON KENWOOD SN ] B
POWER | MON SCN [ |
OPT DA [ |
OPT DiA
I |

1
i2
13
i4
15
16

{ Arrows :  Move Space , F2: Select F10: OPT Aux sel All:Abortt ESC:Return to Edit }
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Full Control Head: Shown below in the middle of the display’is a representation of the full control head
front panel. The functions which can be assigned to MON, SCN, KEY 1, KEY 2, KEY 3 and KEY 4 on

the front panel are listed in the Key Selection window shown in Figure @®.

| Fie Model Edit Program  Setup F1=Help
Basic 99c¢h |Key Seleclion Radio UHF :450-470 Model 83085998
[P LimnA Ll i dvlelwin = Lpiv]
] KENWOOD MON N
POWER
SCN
GRP
KEY 1 KEY 2 KEY 3 KEY 4
12
13
14
15
16
{ Armows: Move Enler: Select Al Golo Menu )
Figure @
Key Selection
spacE Not Used
Mon Monitor .
sci Scan !
Pa Public  Adress
Ha : Horn  Alert
Ta + Talk Around
le : Intercom
An Alphanumeric
Sp Speaker Switch
D/fa Delate f Add
Opt Voice Scrambler
auX Auxiliary

See "* Key function descriptions" following this page for a description of the functions of each of

the key listings.
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* Key function descriptions

Ospace : Not Used
If you select "Not used", the function of the specified key Is disabled.

f
OMon :  Monitor
The assigned key becomes the Monitor switch. (This key is preassigned.)

OscN @ Scan
The assigned key becomes the Scan switch. (This key is preassigned.)

OPa : Public Address
QOutputs audio from MIC te the external speakers.

OHa : Horn Alert
Sounds the horn when you have decoded other signaling.

Ole : Intercom
Works only with the dual contral head configuration. Outputs veice from the other control head
speaker when you press the PTT switch and speak.

OTa : Tak Around

O Alphanumeric
In the case of the basic control head configuration, works only when the KCH-5 option has been
installed. Switches the display between the CH display and a display of programed alphanumeric
characters.

OD/a : Delete /Add
Switches between Delete and Add for scanning. If you do not select this key, Delete/Add is sef to
the value you have selected in the CHANNEL INFORMATION screen.

Qopt
Voice Scrambler
Used to control signaling options and so forth. Designed to be used for a voice scrambler.

Operator Selectable Tone ( QT /DQT )
The tone set with the Feature Qption.

Auxiliary
Controls the auxiliary switch.

OauX
Voice Scrambler
Used to control signaling options and sc forth. Designed to be used for a voice scrambler.

Operator Selectable Tone (QT/DQT )
The tone set with the Feature Option.
Auxiliary
Controls the auxiliary switch.

Note

The OPT key and the Aux key can each have three functions assigned to them. However, you
cannot assign the same functions to both of the keys concurrently. It will be easier to keep track
of the key functions if you assign rames to the control head keys with the KCH-6 option, which
has the various functions printed. '
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® Scan nformation

Allows you to set information related to scanning. Scan Information allows you to specify settings for
Priority 1, Priority 2, Group Scan, Resume Time, Look Back Time A, Look Back Time B, and Revert
Channel. This section describes each of these setting items separately,

(OPRIORITY SCAN ( Priority 1, Priority 2 )
Set one of four selections: NONE, FIXED, SELECTED CHANNEL, or OPERATOR SELECTABLE.
These items have the following meanings as described in the table below when set for PRIOQRITY:

CHANNEL.
SELECTED OPERATOR
NONE FIXED GHANNEL SELECTABLE
PRIORITY 1 CH Both Priority 1 CH | Sets the Priority 1 Sets the channel Allows you to set
and Priority 2 CH are] CH. This channel selected with the  |PRIORITY | CH with
set to "None", and | must be set to RX channel! knob to a control head key.
Priority Scan is FREQUENCY. PRIQRITY | CH
invalidated. before the scanning
operation.
PRICRITY 2 CH |Eliminates PRIORITY !Sets the PRICRITY 2] Sets the channel | Allows you to select
2 CH and performs a; CH. This channel selected with the |PRIORITY 2 CH with
Single Priority Scan | must be set to RX channel knob to a control head key.
of PRICRITY | CH FREQUENCY. PRICRITY 2 CH
only. before the scanning
operation.

The relationship between status combinations of Priority 1 and Priority 2 and Revert CH is described
below. The KPG-7D automatically determines the selection range. Refer to the table and descriptions

below for details.

There are twelve combinations you can select from for Priority 1 and Priority 2. The table 8 - 1 shows
these twelve combinations and the designations for the revert channel assignment which is designated
for the combination you select. There are a total of fifteen revert channels you can assign. You can
select one revert channe! for each of the combinations shown in the table. The table lists the fifteen
designations for the fifteen revert channel assignments that you ¢an select, For the meanings of the
different number designations, see "*Revert Channel assignments”.

40




File Model Prograrn Setup F1=Help
Table 8-1
Pattern PRIORITY 1 CHANNEL PRIORITY 2 CHANNEL REVERT CHANNEL
1 FIXED NONE 0,00,
2 FIXED FIXED 0,000,
3 FIXED OPERATOR SELECTABLE ©,0,0,6,0,0,®
4 FIXED SELECTED CHANNEL 0,,®,(=P2 CH)
5 OPERATOR SELECTABLE FIXED 0,0.0,0,0,0,0,0
6 SELECTED CHANNEL FIXED 2,,0,®(=P1 CH)
7 OPERATOR SELECTABLE NONE @,0,0,0,8,0
8 SELECTED CHANNEL NONE 3.0,6
3 OPERATOR SELECTABLE | OPERATOR SELECTABLE ®,0,0,0,0,6
10 OPERATOR SELECTABLE SELECTED CHANNEL ®,0,8( =P2 CH)
®D,®,0( =P2 CH)
11 SELECTED CHANNEL OPERATOR SELECTABLE ®,0,&( =P1 CH)
{ @®,0,@(=P1 CH)
12 NONE NONE 3,0,

* REVERT CHANNEL ASSIGNMENTS

(DPriority 1 Channel

@ Priority 2 Channel

(®Last Called Channel

@lLast Used Channel

(®)Selected Channel { =Priority 1 Channel or Priority 2 Channel }

®Priority 1 Channel > Priority 2 Channel (Go to P1 CH if one exists, if not, go to P2 CH)

(DPriority 1 Channel > Last Called Channel (Go to P1 CH if one exists, if not, go to last called CH )

@®Priority 1 Channel > Last Used Channel( Go to P1 CH if one exists, if not, go to last used CH)

@Priority 1 Channe! > Selected Channel (Ge to P1 CH if one exists, if not, go to selected CH)

@Priority 2 Channel > Last Called Channel (Go to P2 CH if one exists, if not, go to last called CH}

@ Priority 2 Channel > Last Used Channel( Go to P2 CH if one exists, if not, go to last used CH)

@ Priority 2 Channel > Selected Channel { Go to P2 CH if one exists, if not, go to selected CH)

®P1 CH > P2 CH > Last Called Channel{ Go to P1 CH if one exists, if no P1 CH exists, go to P2 CH,
if no P2 CH exists, go to last called CH)

®Pi CH > P2 CH > Last Used Channe! { Go to P1 CH if one exists, if no P1 CH exists, go to P2 CH,
if no P2 CH exists, qo to last used CH )

®pP1 CH > P2 CH > Selected Channel (Go te P1 CH if one exists, if no P1 CH exists, go to P2 CH,

' if no P2 CH exists, go to selected CH )
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OGROUP SCAN .
Selects either Single Group Scan or Mulli Group Scan. However, it works only with the full-featured
control head configuration.
a.Single Group Scan
Selecting Single Group Scan allows you to scan only those channels in the group selected with the
Group swiich for which “Add" has been set.
b.Muiti Group Scan
Selecting Multi Group Scan allows you to scan only those channels which satisfy two criteria:
1) they belong to a group for which "Add" has been set with the Group Del/Add setting, and
2) "Add" bas been set for the channels as well.

ORESUME TIME
Specifies the time interval from loss of carrier until start of scan when scanning has stopped. The setting
range is from 0 1o 5.0 seconds, and is settable in increments of 0.1 second. The default value is 0.8

seconds.
i

OLOCK BAGK TIME

The cycle time for scanning pricrity channels when scanning of other channels has stopped.

a.LOOK BACK TIME A
The time interval during which there is no carrier for the PRIORITY CH. The setling range is from
350 to 2900 mill seconds, and is settable in increments of 50 mill seconds. The default value is
350 mill seconds.

b.LOOK BACK TIME B
The time interval during which there is a carrier for the PRIORITY CH, but the signaling (QT, DQT)
is different. The setting range is from 350 to 5450 mill seconds, and is setiable in increments of
100 mill seconds. The default value is 2050 mill seconds.

OREVERT CHANNEL

The channel to which the transceiver returns when scanning has stopped. To stop a scan, put the
microphone in the off-hook state. The channels which can be set as revert channels are determined by
the PRIORITY CH setting. If you change the PRIQRITY CH settings, the revert channel setting returns to
its default value. For details, see "PRIORITY CH".

@ Feature Option
You can set ten features as software options with the Feature Option selection. Feature Option includes
ten items which can be set: Time Out Timer, Busy Channel Lockout, Off-Hook Decode Enable, Power On
Tone, Control Tone, Warning Tone, Roll Over, Priority CH Temporary Delets, Monitor Gther TX Audio,
and Operator Selectable Tone Code. Each of these itens is explained separately below.

OTime Out Timer
Sets the Time Out time for transmission. It can be set to OFF (unlimited), or from 15 to 225 seconds.
This setting can be specified in 15-second steps, and the default setting is 180 seconds.

(OBUSY CHANNEL LOCKOUT
Prohibits transmission if there is a carrier on the selected channel which does not match the tone or code
for the channel. The default is "No".
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(QOOFF HOOK DECODE ENABLE

Normally, the transceiver enters monitor state when it is off hook; QT/DQT and the decoding functions for
other signaling options are disabled, and the received signals are output to the speakers. However, this
function enables QT/DAT and the decoding functions for other signaling options even when the
microphone is off hook. Functions such as stopping a scanning operation by taking the microphene off-
hook, and restarting the scanning operation by placing the microphone on-hook are not changed.

OROLL OVER
Sets whether the CH Select Knob will be set for endless operation or not. If YES is selected, the knob is
set for endless operation. If NO is selected, the knob will end at “Stop Dead End".

OPOWER ON TONE
Beep tone at radio power up.

OCONTROL TONE
Key and selector knob echo-back beeps.

OWARNING TONES
PLL unlock , Time-out timer & busy ¢h lockout alert tones.

QOPRIORITY CHANNEL TEMPORARY DELETE
Allows you to temporarily delete priority channels while scanning them. The defauit setting is "NO".

QOOPERATOR SELECTABLE TONE ( QT / DQT )

Sets 16 types of tones or codes that can be adjusted by the operator in addition to the signalling
(QT/DQT) set for each channel. You must assign OPT {operator Selectable) to a controt head key to use
this function.

OTX AUDIO MONITOR
Works only with the dual contro! head configuration. This function monitors audio when the transmission

is performed by the other control head.

®Embedded Message
This message can be written to the radio making it convenient {o use for an electronic serial number,

user name and address management.
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8-2 Key Seletion ;

This section describes how to set the key assignments.

1 Open the Edit menu window. ({section 5-2)

2 Move the cursor to "Key Selection” with the up- or down-arrow key , and press the Enter key.
You can also use the Quick Key for the selection. The window shown in Figure & will open if you
have a basic control head configuration, and the window shown in Figure ® will open if you have a
full control head configuration.

Figure &
MON
KENWOOD SCN l |
POWER I |
Figure ®
KENWCGD MON
POWER
SCMN
GRP
KEY 1 KEY 2 KEY 3 KEY 4
3 Use the arrow keys to move the cursor to the key you wish to assign a function to, and press the
Enter key. The window shown below then opens.
Key Selection
space : Not Used
Mon : Monitor
scN : Scan
Pa . Public  Adress
Ha ;. Hom  Alert
Ta i Talk  Around
Ie : Intercom
An :  Alphanumeric
Sp : Speaker Swilch
C/a : Delgte / Add
Om . Voice  Scrambler
auX : Auxiliary
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4 Select the desired function with the up- or down-arrow key or the Quick Key {section 3-1 or 3-2).
See “* Key Function Descriptions" in Section 8-1 for a description of the functions of the items in
this window. Once you have completed the setting, the selected function is displayed in the box
and the cursor then moves to the next item.

5 Press the Alt key to close the Key Selection window and return your monitor to the previous

screen,
6 If you set the OPT key or the AUX key, you must select a function for it. Press the F10 key. The

window shown below then opens.

OPT KEY AUX KEY
[ Veice Scrambler ] [ Auxiliary ]
Veice Scrambler Operatior Selectable Tone
Operater  Selectable Tone Auxiliary

7 Use the up/down and leftright-arrow keys to select the function you wish to set. (section 3-1)

Note : The same function cannot be assigned to both the OPT key and the AUX key concurrently.
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8-3 Scan Information

This section describes how to set Scan Information.  First, open the Edit menu window (section 5-2). Next,
move the cursor to "Scan Information” with the up- or down-arrow key , and press the Enter key. You can also
use the Quick Key for the selection. The Scan Information window shown below opens. The operations to set
each of the items in this window are described below. When you have completed the setting for each item, the
cursor moves to the next item. When you are finished, press the Alt key to close the Scan Information window.
The display then returns to the previous screen.

® Priority 1
1

{or

@ Priority 2
1

2

{or

Scan  Information

Prgrity 1 [ None 1

Pricrity 2 [ None 1

Group Scan i Single 1

AResume Time [ 0.8 1Sec [ 00 — 5.0 Sec )

Look Back Time A [ 350 Jmsec { 350 — 2900 msec )

Look Back Time B [ 2025 )msec { 350 — 5450 msec )
i

Reveri Channel Selected Channel ]

Move the cursor to "Priority 1" with the up- or down-arrow key, angd press the Enter key. The
sellings window opens.

Select the setting you wish fo specify with the up- or down-arrow key or the Quick Key. (section
3-1 ar 3-2)

Press the F2 key or the space bar to move through the function selections one by one. Select the
function, and press the Enfer key. )

Move the cursor to "Priority 2" with the up- or down-arrow key, and press the Enter key. The
settings window then opens.

Select the setting you wish to specify with the up- or down-arrow key or the Quick Key. (section
3-1 or 3-2)

Press the F2 key or the space bar to move through the function selections one by one. Select the
function , and press the Enter key. }

@ Group Scan

1

(or

Move the cursor to "Group Scan" with the up- or down-arrow key, and press the Enter key. The
settings window then opens.

Select the setling you wish to specify with the up- or down-arrow key or the Quick Key. (section
3-1 or 3-2)

Press the F2 key or the space bar to move through the function selections one by one. Select the
function , and press the Enter key. )

® Resume Time

1

2
(or

Move the cursor to "Resume Time” with the up- or down-arrow key.
Enter the desired time, and press the Enter key

Press the F2 key 1o change the setting in 0.1-second increments. Select the desired time | and
press the Enter key. )
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@ Look Back Time A
1 Move the cursor to "Look Back Time A" with the up- or down-arrow key.

2 Select the desired time, and press the Enter key
{or  Press the F2 key to change the setting in 50-millisecend increments. Selct the desired time, and

press the Enter key)

@ Lock Back Time B
1 Move the cursor to "Look Back Time B" with the up- or down-arrow key.
2 Select the desired time, and press the Enter key
(or  Press the F2 key to change the setting in 100-millisecond increments. Selct the desired time, and

press the Enter key)

@ Revert Channel
1 Move the cursor to "Revert Channel” with the up- or down-arrow key, and press the Enter key.

The settings window then opens.

2 Select the revert channel you wish to specify with the up- or down-arrow key or the Quick Key.

(section 3-1or 3-2)
(or  Press the F2 key or the space bar to move through the selections one by one. Select the revert

channel, and press the Enter key)
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8-4 Feature Option

This section describes how to set the Feature Option items. First, open the Edit menu window (section 5-2).
Next, move the cursor to “Feature Cption™ with the up- or down-arrow key or the Quick Key, and press the
Enter key. The Feature Option window shown below opens. The operations to set each of the items in this
window are described below. When you have completed the setting for each item, the cursor moves to the next
item. When you are finished, press the Alt key to clase the Feature Option window. The display then returns to

the previous screen.

Feature Oplion

Time Qut Timer I 18 1 GFF, 15 — 225 sec
Busy Channel Lockout [ Yes |

OFF Hook.Decode Enable [ Yes ]

Power ON Tone [ Yes )

Coniral Tone { Yes )

Warning Tone [ Yes }

Rall Over [ Yes |

Scramble Code Selectable [ NG ]

Priority Temporary Delete I NO ]

User Selectable Code

® Time Qut Timer :

1

2
{or

Move the cursor to "Time Out Timer™ with the up- or down-arrow key.

Enter the desired tims, and press the Enter key.
Press the F2 key to change the setting in 15-second increments. Select the desired time, and

press the Enter key.)

® Busy Channel Lockout

1

(or

Move the cursor ta "Busy Channel Lockout" with the up- or down-arrow key, and press the Enter
key. The settings window then opens.

Select either {Yes] or [No] with the up- or down-arrow key or the Quick Key. {section 3-1 or 3-2)
Press the F2 key or the space bar to alternate between the [Yes] and [No] settings. Select either
[Yes] or [Ne], and press the Enter ksy.)

@ OFF Hook Decode Enable

1

2
{or

Move the cursor to "Off Hook Decode Enable” with the up- or down-arrow key, and press the
Enter key. The seltings window then opens.

Select either [Yes] or [No] with the up- or down-arrow key or the Quick Key. (section 3-1 or 3-2)
Press the F2 key or the space bar to alternate between the [Yes] and [No] settings. Select either
{Yes] or [No], and press the Enter key.)

@ Power ON Tone

1

2

{or

Move the cursor to "Power ON Tong"” with the up- or down-arrow key, and press the Enter key.

The settings window then opens.
Select either [Yes] or [No] with the up- or dovm-arrow key or the Quick Key. (section 3-1 or 3-2)
Press the F2 key or the space bar to alternate between the {Yes] and [No] settings. Select either

[Yes] or [Nel, and press the Enter key.)
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® Control Tone

1

2
(or

iove the cursor te "Control Tong” with the up- or down-arrow key, and press the Enter key. The
settings window then opens.

Select either (Yes] or [No} with the up- or down-arrow key or the Guick Key. (section 3-1 or 3-2)
Press the F2 key or the space bar to alternate between the [Yes] and [No] settings. Select either
[Yes] or [No] , and press the Enter key.)

@ \Warning Tone

1

2
(or

® Roll Over
1

(or

Move the cursor to “Warning Tone" with the up- or down-arrow key, and press the Enter key. The
settings window then opens.

Select either [Yes] or [No] with the up- or down-arrow key or the Quick Key. (section 3-1 or 3-2)
Press the F2 key or the space bar to alternate between the [Yes] and [No] settings. Select either
[Yes] or [No}], and press the Enter key.)

Move the cursor to "Roll Cver” with the up- or down-arrow key, and press the Enter key. The
setlings window then opens.

Select either [Yes] or [No] with the up- or down-arrow key or the Quick Key. {section 3-1 or 3-2)
Press the F2 key or the space bar to alternate between the [Yes] and [No} seltings. Select either
[Yes] or [No}, and press the Enter key.)

@ Priority Temporary Delete

1

{or

Move the cursor to “Priority Temperary Delete" with the up- or down-arrow key, and press the
Enter key. The settings window then opens.

Select either [Yes] or [No] with the up- or down-arrow key or the Quick Key. (section 3-1 or 3-2)

Press the F2 key or the space bar to alternate between the [Yes] and [No] settings. Select either
[Yes] or [No], and press the Enter key.)
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® Operator Selectable Tene (QT/ DQT )
1 Move your cursor to “Operator Selectable Tone” with the up- or down-arrow key, and press the

Enter key. The settings window shown below opens.

Code

Decode

Encode

o ~{om|a &M=

18

2 Move the cursor to the location you wish to input a code with the up- or down-arrow key.

3 Enter the code you wish to specify, and press the Enter key.
(or  Press the F2 key 1o open the Tone window, Select the desired tone from this window, and press

the Enter key. )

4 Once you have finished entering all the codes, press the Alt key. The settings window closes, and
the display retumns to the pravious screen.

@ Monitor Other TX Audio

1 Move the cursor to "Monitor Other TX Audio” with the up- or down-arrow key, and press the Enter

key.

2 Select either {Yes] or [No] with the up- or down-arrow key or the Quick Key. (section 3-1 or 3-2)
{or Press the F2 key or the space bar to alternate between the [Yes] and [No] settings. Select either
[Yes] or [No], and press the Enter key. )
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9 Program

Allows you to read data from the transceiver, and write data to the transceiver.
(Make sure that transceiver is set to the programming mode. Refer to Section 1-2)

Contents of this chapter

1 T O = 0= - o J P51
4 T = S T P52
9-1 _ Read
1 Open the Program menu window. (section 5-2)
2 Move the cursor to "Read" with the up- or down-arrow key, and press the Enter key. The window

shown below then opens.

Read Dala From The Radio.

{ OK ] [ Canzel ]

3 Selact either [OK] or [CANCEL] with the left- or right-arrow k% or the Quick Key (section 3-1 or
3-2). If you select [OK], data are read from the transceiver. The window shown below then
opens, indicating that the procedure has been completed

Done Reading The Radio Data

Hit any key

If you select [CANCEL], data are not read, the window closes, and the display returns to the
previous screen.

Note The window shown below opens if your computer and transceiver are not connected properly. In this
case, you must check the connection to see whether the equipment is connected properly or not.

ERROR

Check connestion. Relry or Cancel

[ Retry ] [ Cancel ]

Select either I[OP( or {CANGCEL] with the left- or right-arrow key or the Quick Key (section 3-1 or
3-2) If you select [ Cancel ], , the display return to the program menu window. Set the transceiver
in programming mode. Verify that the transceiver and the computer are connected properly with

KPG-4 and select [ Retry ] .
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9-2 Write
1 Open the Program menu window. (seclion 5-2)
2 Move the cursor to "Write" with the up- or down-arrow key, and press the Enter key. The window

shown below then opens.

Wrila Data To The Radio.

[ OK 1] [ Cancel 1

3 Select either [OK] or [CANCEL] with the left- or right-arrow key or the Quick Key (section 3-1 or
3-2). If you select [OK], data are written to the transceiver. The window shown below then opens,
indicating that the procedure has been completed

Done- Wriling The PC Data

Hil any key

If you select [CANGEL], data are not written to the transceiver, the window closes, and the display

returns to the previous screen. i

Note The window shown below cpens if your computer and transceiver are not connected properly. In this
case, you must check the connection to see whether the equipment is connected properly or not.

ERROR
Check conneclion. Relry ar Cancel

[Rotry ] [ Cancel ]

Select either [OK] or {CANCELY} with the left- or right-arrow key or the Quick Key {section 3-1 or
3-2). Set the transceiver in programming mode. Verify that the transceiver and the computer are

connected properly with KPG-4 and select [ Retry 1. If you select [ Cancel |, the display return
to the program menu window.
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10 Set up

The Set-up allows you to set the communication port, display color, and Help path.

Contents of this chapter

f

10-1 Communication port ... ... i i i i e i e P53
10-2 DISplay COlOr ... i i it it e et P54
10-3 Help Path ... i i e P55

10-1  Communication port

Sets the communication port, either COM 1 or COM 2, for the connection between the transceiver and your

computer.
1 Open the Setup menu window. (section 5-2)
2 Move the cursor to "Communication port" with the up- or down-arrow key, and press the Enter

key. The window shown below then opens,

SET UP  Communication Port

[ comi ] [ com2 |

3 Select either [COM 1] or [COM 2] with the left- or right-arrow key or the Quick Key {section 3-1
or 3-2).

Note If there is only a COM 1 port on you computer, the window shown below opens. You can press any
key. The communication port is autornatically set to COM 1.

There is no COM 2 Porl
Now selecled COM 1 PORT.

HIT any key.

q Once you have completed the setting, prass the ESC key. The window closes, and the display
returns to the CHANNEL INFORMATION screen.
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10-2 Display color

Display Color can be set to either color mode or black and white mode. If you select color mode, you can

change the colors of the menu bar, windows, and so forth.

1 Open the Setup menu window. (section 5-2)

2 Move the cursor to "Display Color" with the up- or down-arrow key, and press the Enter key. The

window shown below then opens.

Display Color Mode

[ COLOR } [ Black & White ]

3 Select either [COLOR] or [Black & White] with the left- or right-arrow key or the Quick Key.

(section 3-1or 3-2)

4 If you select [Black & White], your display screen is set to display in black and white. {f you select
{COLOR], The window shown below opens.
1
Sel up Display Color
Display Back Cofor Blug
Input Pata Color Brown
Feature High light Color Magenta
Screen Border Info. Color Green
Windows Menu Color Cyan
General Message Color Red
Windows Color lightgray
5 Move the cursor to the item you wish to set a color to with the up- or down-arrow key, and press
the Enter key. The following window opens.
blAk
blUe
Green
Cyan
Red
Magenta
brOwn
Lightgray
] Select the desired color with the up- or down-arrow key or the Quick Key (section 3-1 or 3-2).

Pressing the F10 key, then the Enter key returns all colors to Lheir initial settings.

7 Repeat steps 5 and 6 to set the colors for the other items.

8 Once you have completed all the settings, press the ESC key. The window closes, and the
display returns to the CHANNEL INFORMATION screen.
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10-3 Help Path
Use Help Path te set the drive and path name of the Help File.

1 Open the Setup menu window. (section 5-2)

2 Move the curser to "Help Path" with the up- or down-arrow key, and press the Enter key. The
window shown below then opens.

Setup Dvive & Path for Help File
Drive & Paht : A :\VKPG7D

3 Enter the drive and path namae direcily from the keyboard (section 3-3). The window closes, and
the display returns to the CHANNEL INFORMATION screen.

Note However, if there is no the drive and path name you have entered, the window shown below opens.
Verity whether or not the drive and path name exists . Press the Alt key and enter the correct drive
and path name.

ERROR |

Drive & Path not found
Hit any key

Note However, if there is no help file at the location indicated by the drive and path name you have entered,
the window shown below opens. Verify whether or not the help file exisis at that location. Press the
Alt key and enter the correct drive and path name.

ERROR |

Help file nol {ound. Hit any key.

55



[ File Model Edil Program Satup

11 F1 =Help
General Help and Keyboard Help are accessed from the F1 =Help menu. General MHelp
shows the screen organization. Keyboard Help shows how to use the keyboard.

Contents of this chapter

11-1 General Help ..o oo e it s P56
11-2 Keyboard Help ... i it i P56
11-3 Keys youcan use inthe Helpscreen .................coiiiilt P57

11-1 General Help

1 Open the F1 =Help menu window. {section 5-2)

2 Move the cursor {o "General Help" with the up- or down-arrow key, and press the Enter key. The
Help screen is then displayed. [f you press the Alt key, the Help screen closes, and the display
returns to the previous screen.

H.1 = [ General Help ] ™

Along the top border of the main program screen ( Channel Info. ) are

the “drop down " menus_ { press ALT ; use the cursor keys --— & - to select
a program section. Hel;!): is available for each menu by pressing the F 1
function key. Pressing F 1 while in the channel Info. screen will load

it's Help screen. To get familiar with the computer key functions used

in the KPG - 7D, hit ALT now ; select Ketboard Help ; hit ENTER . Within

a Help screen use cursor up / down to scroll 5 F 5 to print a hardeopy ; and
ESC or ALT to escape the screen. Refer to the KPG - 7D Instruction Manual
for additional help. . )

“Basic Use [nstructions ( use F 1 for Help in each program section below } *

A. [ CREATING PROGRAM DATA FOR A MOBILE ]
1. Open “MODEL” menu and select the appropriate model type.
2. Open “EDIT - Key Selection”_menu an assign a function to keys on the
control head. ( hint : use ALT to return to EDIT menu )
Open “EDIT - Scan Information” menu ; set SCAN features & parameters.
4. Open "EDIT - Feature Option” menu : set the general built - in features.
5. Hit ESC : the cursor wiill move the main screen, “CHANNEL

INFORMATION"
11-2 Keyboard Help
1 Open the F1 =help menu window. (section 5-2}
2 Move the cursor to "Keyboard Help” with the up- or down-arrow key, and press the Enter key.

The Help screen is then displayed. If you press the Alt key, the Help screen closes, and the
display returns to the previous screen.

= H.2 ** [ Computer Keyboard Help ] ™

guréently available keys functions are displayed on the bottom screen
araer

ESC : returns to the main screen ; Channel Information
{ exits menus & sub - screens ) . ]
ALT © “Go to Menu” or “Go back” to previous screen.
CURSOR Keys : moves cursor within a data input field ;
scrolls help screens.
PgUp & PgDn : pages up / down Channel Group & Help screens.
F 1 : Opens a Help screen. ‘
F 2: through F 10 : Selects labeled functions in shown at screenbottom.
F 2 : Toggles Yes / No or increments selection in data fields.
Shift + F 2 : Decrements selection in data fields.
F 3 : Copies the current channe! data to another channel.
F 4 : copies a RX frequency column entry to the TX frequency column.
F 5 : Prints the current Help screen.
F 7 : Next page / channel group { same as page up )
F 8 : Previous page / channel group ( same as page down )
F 10 : Priority channel set
Shift + F 3 7 Copies an entire channel group to other channel group.
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11-3__Keys you can use in the Help screen
You can use the following keys in the Help screen:

Q[At)Key ... Exits Help and returns to the previous screen.
@[ESCIKey ..., «Réturr;s'*“thg_qjs;play to the CHANNEL INFORMATION screen.
®UparowKey .................. * Serolls the screén up.

®Down arrdw Key ....... : e . Serolls the screen down.

O®[F5)Key ... . Prints out belp information.

@[ F7 ] Key (Page Down) ........ Displays the next page.

@®[F8 ] Key (Page Up) ........... Displays the previous page.
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